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license to any intellectual property rights is granted by this document. 
 
The screens, procedural steps, and sample reports in this manual may be slightly different from the actual 
software due to modifications in the software based on state requirements and/or school district 
customization. 
 
The data in this document may include the names of individuals, schools, school districts, companies, 
brands, and products. Any similarities to actual names and data are entirely coincidental. 
 
Synergy SIS is a trademark of Edupoint Educational Systems, LLC. 
* Other names and brands may be claimed as the property of others. 
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ABOUT THIS MANUAL 
 
Edupoint Educational Systems develops software with multiple release dates for the 
software and related documentation. The documentation is being released in multiple 
volumes to meet this commitment. 
 
The table below lists the release date, software version, documentation volume number, 
and the content included in each volume of documentation to date. 
 
Software and Document History 

Date  Volume  Edition  Revision  Content 

October 2009 1 1 1 Initial release of this document 

March 2010 1 1 2 Updated for the November 2009 
release and the February and March 
2010 patches. 

July 2011 1 1 3 Updated for the July 2011 release 

August 2012 1 1 4 Updated with the most current 
hardware and software 
requirements 

March 2013 1 1 5 Updated for the February 2013 
release 
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CONVENTIONS USED IN THIS MANUAL 
 

Bold Text Bold Text - Indicates a button or menu or other text on the screen to 
click, or text to type. 

 

Tip – Suggests advanced techniques or alternative ways of 
approaching the subject. 

 

Note – Provides additional information or expands on the topic at 
hand. 

 

Reference – Refers to another source of information, such as 
another manual or website 

 

Caution – Warns of potential problems.  Take special care when 
reading these sections. 

 
 
BEFORE YOU BEGIN 
 
Before installing any of the Edupoint family of software products, please be sure to review 
the system requirements and make sure the district’s computer hardware and software 
meet the minimum requirements.  If there are any questions about the system 
requirements, please contact an Edupoint representative at (877) 899-9111.   
 
 

  

Caution:  The Edupoint family of software does not support the use of 
pop-up blockers or third-party toolbars in the browser used to access 
Synergy SIS.  Please disable any pop-up blockers (also known as pop-
up ad blockers) and extra toolbars in the browser before logging into 
any Edupoint product. 

 
 
At any point, if there are any technical difficulties, please contact the Edupoint technical 
support team at support@edupoint.com or by phone at 1-877-899-9111 option 1. 
 
 
  

mailto:support@edupoint.com
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Chapter One: 
OVERVIEW 

 
 
 
 
 
 
 
 
 
 
 
 

In this chapter, the following topics are covered: 
► Overview of installation 
► Implementation considerations 
► Sample deployment configurations 
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OVERVIEW OF INSTALLATION 
 
The Synergy SIS software has three main components:  the web server, the process 
server, and the database server.   

• The database server houses the database for all districts and schools.  Unlike 
other student information systems, all data is kept in one database for all schools for 
all years, which simplifies the system administration and reduces duplicate data 
entry and errors. 

• The process server processes all reports and other jobs that may be resource-
intensive such as the new year rollover.  By separating these jobs onto a separate 
server or servers, this improves performance for the end-user. 

• The web server presents the end user interface.  The software is accessible via a 
web browser, and it has four interfaces – one for teachers called TeacherVUE, 
another for teachers using Grade Book, another for parents and students using the 
ParentVUE or StudentVUE portals, and another for all staff as the main Synergy SIS 
interface. 

 
Each of these three main components may also be configured as a separate testing and/or 
training environment.  There are also other software programs that integrate with the 
Synergy SIS software but are installed separately, such as the Generic Conversion 
software.  The installation of the three main components, the training/testing software, and 
the other software programs is covered in Chapter Three of this guide. 
 
Prior to installation of the software, there are a number of hardware and software 
requirements that must be configured.  These requirements are outlined in Chapter Two of 
this guide. 
 
Synergy SIS is constantly being improved and refined based on user feedback.  A major 
software upgrade is available once a year in November, and continuous enhancements 
(CE) and targeted updates (UT) are released as frequently as once a month.  Edupoint 
offers all software releases free of charge to current customers.  Instructions for installing 
these releases are available in Chapters Four and Five of this guide. 
 
 

IMPLEMENTATION CONSIDERATIONS 
 
When determining how to install and configure Synergy SIS, there are several factors to 
take into consideration.  These factors include: 
 
How will the software be accessed? 
Synergy SIS is a web-based system accessible via any Internet browser.  Consequently, it 
can be accessed via a district’s internal LAN/WAN environment or it can be accessed over 
the Internet.  Alternatively, it can be setup as a mixed system where parents & students 
access the information over the Internet using the ParentVUE & StudentVUE software, and 
staff & teachers access it over the LAN.  Only the web servers need to be accessed by the 
end users, and the web servers can be configured with dual NICs to communicate with the 
process servers and database servers secured in the LAN environment. 
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How many servers will be purchased, and what types of servers? 
Synergy SIS has three main components – the web server, the process server, and the 
database server.  The database is generally installed on only one server, protected in the 
LAN environment.  Depending on the size of district, multiple process and web servers may 
be needed to handle the number of users accessing the system.  For more information 
about server sizing, please see the section on Recommended Hardware Configuration in 
Chapter Two. 
 
What additional software will be installed? 
Besides the three major components, there are also several smaller software programs that 
integrate with the Synergy SIS software.  The district needs to decide which software 
programs will be installed, and where these programs will be installed.  For a list of these 
programs, please see the section on Other Synergy SIS Software Installation in Chapter 
Three. 
 
Will separate testing and training environments be needed? 
In addition to the main production environment, Synergy SIS can also be setup in a 
separate configuration for testing and training.  The district will need to decide how many 
testing & training environments will be configured, and where these environments will be 
setup. 
 
How many end users will be accessing the system, and what types of users? 
Synergy SIS has a separate software program, the ParentVUE & StudentVUE software, 
which can be installed for use by parents and students.  There is also a separate interface 
for teachers called TeacherVUE.  To help determine the configuration of the Synergy SIS 
installation, it will be necessary to estimate how many of each type of users will be 
accessing the software at the same time. 
 
How will the software be introduced to the staff? 
Many districts implement Synergy SIS in stages.  Perhaps only the elementary schools are 
converted and transitioned to Synergy SIS one year, and then the high schools the next 
year.  Smaller districts may choose to convert the entire district in one year.  Sometimes 
Synergy SIS is run in parallel with the old system for a time until everyone is trained and 
comfortable with the new software.  For more about data conversion, please see the 
Synergy SIS – Data Conversion Guide. 
 
 

SAMPLE DEPLOYMENT CONFIGURATIONS 
 
When determining what pieces of Synergy SIS are installed on which servers, several 
factors to consider include: 

• What servers will be used for the Synergy SIS Production and/or Synergy SIS 
Testing/Training web servers 

• What web servers, processes and organizations will be supported by each process 
server 

• Where the training/testing database and the production database will be located 

There are a number of ways to implement Synergy SIS.  These install instructions will work 
for each of these implementations.  The key is to complete the install process step for each 
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type of server completely.  For example, if there are multiple web servers, complete the 
update to each of them before updating the process servers. 
 
Possible Server Configurations 
 
Stand Alone  
The simplest implementation is a single server.  In this example, the web site (IIS), process 
server, and database are all installed on the same server.  This would be appropriate for a 
very small school district, or possibly for a training or test environment. 
 

 
Figure 1.1 – Stand-Alone Server 

 
Two-Server Configuration  
A two-server configuration could be implemented with two possible scenarios.  The first 
would be with IIS and the process server on the web server and the database on the other.  
This setup isolates the database, but may result in a slower response time to the user when 
a user is running reports, queries, or batch processes.   The second scenario is to have IIS 
only on the web server, and the process server and database on the second server.  This 
should result in a more consistent user response time regardless of the work being 
performed by the process server. 
 

 
Figure 1.2 – Two Servers (Database) 

 
Figure 1.3 – Two Servers (Web) 
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Web Farm  
This configuration is ideal for large school districts with many users.  Here multiple IIS web 
servers [termed a web farm], and multiple process servers are implemented along with a 
single database server.  The number of users and the size of the district determine the 
number of web servers and process servers needed.  This configuration ensures a good 
users response time regardless of the large number of users in the district.  
 
 

 
Figure 1.4 – Sample Internal Network Configuration 
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Chapter Two: 
PREPARATION 

 
 
 
 
 
 
 
 
 
 
 
 

In this chapter, the following topics are covered: 
► Recommended systems configuration 
► Pre-installation preparation 
► .NET Configuration 
► Database Configuration 
► How to download the latest release 
► How to install the demo database 
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RECOMMENDED HARDWARE CONFIGURATION 
 
Synergy SIS distributes the primary functions of the Synergy SIS software over three types 
of servers; web, process, database.  ParentVUE & StudentVUE may also be installed on a 
separate web server to set different access or security rights to that server. 
 

Web Server 
Synergy SE Software 
Synergy SIS Software 

 
Process 
Server 

 Database 
Server 

ST_Production 
ST_Training 

ST_Test 

 
ParentVUE & 
StudentVUE 

Server 

Edupoint recommends: 
− one or more separate computers for each of these four server types 
− at a minimum, customers acquire, configure, and maintain separate computing environments for Production, Training, 

and Testing. 
 

• Web servers are the front-end servers that host the website for the end users. 

• Process servers run the reports and other resource-intensive processes.  These 
processes are usually started and controlled through the web front-end. 

• Database servers store all student data.  

• ParentVUE & StudentVUE servers are additional web servers that provide read-
only data to students and parents through a web browser.  These servers must be 
accessible from the Internet. 

 
Schools and districts should carefully consider the computing power they put in place to 
support each of these three server functions within their production, training, and testing 
environments.  While all of these server functions could reside upon one underlying 
computer, Edupoint recommends one or more separate computers for each of these 
functions.  Edupoint also strongly recommends that separate production, training and 
testing environments be maintained. 
 
The key variable that will determines the number of servers needed for each function is the 
number of end users using the various functions at the same time.  Be sure to take into 
consideration daily and seasonal spikes in usage such as the start or end of the school day, 
the start of a school year or semester, report card generation, or year-end processing. 
 
Since everyone’s budgets are tight, it may not be possible to purchase enough servers to 
handle the time periods when peak loads occur.  Possible strategies that can be deployed 
to minimize or handle spikes in server demand are: 

• Stagger deadlines across the district. 

• Establish different “acceptable performance” standards for normal and peak 
demand periods and also for the type of job (e.g., data entry vs. report preparation 
and printing, etc.), and include these standards in any end-user training.  

• Be prepared to adjust priorities for the job queuing algorithm on the servers in the 
server farm to favor critical users/jobs over non-critical users/jobs, or direct less time 
sensitive but resource intensive processes such as printing and reporting to specific 
servers.  
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• Size and configure the servers based on the end user’s assessment of peak loads.  

• Be prepared to temporarily ramp up the available server time to support events that 
cause a spike in demand.   

 
Tools that can help monitor server usage and assist with load balancing include the tools 
provided in Microsoft Advanced Server 2003 or 3rd party software such as SysTrack.  Prior 
to Synergy SIS deployment, load simulation software may help a district determine the 
exact configuration needed for their environment. 
 
Please refer to the latest version of the “Edupoint Hardware and Software Requirements” 
document for guidelines on the hardware and software required to run Synergy. 
 
While the guidelines in the “Edupoint Hardware and Software Requirements” provide a 
basis for the initial configuration, districts and schools should be prepared to quickly resize 
and reconfigure their computing environments based upon their own “acceptable 
performance” standards.  If needed, Edupoint does offer consulting services at an 
additional cost to assist districts and school with server sizing and implementation. 
 
 

  

Caution:  Edupoint provides these recommendations, but makes no 
representations, warranties, or claims that by following these 
recommendations a given customer will experience “acceptable 
performance.”  Customers are advised to use this information in 
combination with their own technical knowledge and understanding of 
their network environment to determine the hardware configuration for 
the Synergy SIS servers.  The above recommendations are the only 
recommendations made by Edupoint in regards to sourcing, sizing, and 
configuring servers for the installation and operation of Synergy SIS.  No 
other recommendations are offered by Edupoint, whether stated 
verbally, or within other working papers, e-mails, or project documents 
shared prior to the date of this document.  No other recommendations 
are valid or binding on Edupoint. 

PRE-INSTALLATION CHECKLIST 
 
Before installing Synergy SIS, the following software must be configured on installed on 
each server.  Synergy SIS supports 64-bit installations.  When installing the software listed 
below, the default installation options from Microsoft are fine. 
 
Database Server 
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1. Install Windows Server (64-bit version of 2008).  No roles or features are required. 

2. Install anti-virus software.   

3. Install SQL Server 2008 R2 Standard 64-bit installation, and install all service 
packs and updates. 

4. Install all Microsoft patches and updates. 

5. Configure the database as outlined in the Database Configuration section later in 
this chapter. 

6. Setup a database maintenance plan through SQL Server. 

7. Setup daily database backups. 

8. Enable secure remote access for Edupoint support, and provide Edupoint with 
remote access information.  Edupoint must have administrator-level access to the 
server and Windows-integrated administrator access to SQL server to install the 
Synergy SIS software.  Remote Desktop is preferred, either through a secure VPN, 
from another computer accessible from the Internet via Remote Desktop, or directly 
to the server. 

Web Servers & Process Servers 

1. Install Windows Server (64-bit version of 2008).   

2. Install anti-virus software.   

3. Add the Web Server role for Windows 2008.  Select the following features for the 
Web Server role in 2008: 
Common HTTP Features 

Static Content 
Default Document 
Directory Browsing 
HTTP Errors 

Application Development 
ASP.NET 
.NET Extensibility 
ASP 
ISAPI Extensions 
ISAPI Filters 

 

Health and Diagnostics 
HTTP Logging 
Request Monitor 

Security 
Basic Authentication 
Windows Authentication 
Digest Authentication 
Request Filtering 
IP and Domain Restrictions 

Performance 
Static Content Compression 

Management Tools 
IIS Management Console 
IIS Management Scripts and Tools 
IIS 6 Management Compatibility 
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4. To send e-mail from Synergy SIS, install the Default SMTP server on one of the 
servers, or configure an existing e-mail server to accept SMTP traffic from the 
Synergy SIS servers.   

5. If some web servers will be installed outside the firewall, verify that they can 
communicate with the database and process servers. 

6. Install the .NET 4.0 Framework and set it as the default ASP .NET service (if not 
already).  See the section in the chapter on .NET Configuration for instructions if this 
needs to be installed and configured. 

7. For districts using the Grade Book, install Microsoft Report Viewer 2010 on the 
process server.  This can be downloaded from Microsoft for free at 
http://www.microsoft.com/download/en/details.aspx?displaylang=en&id=6442 

8. Install all Microsoft patches and updates. 

9. Enable secure remote access for Edupoint support, and provide Edupoint with 
remote access information.  Edupoint must have administrator-level access to the 
server and Windows-integrated administrator access to SQL server to install the 
Synergy SIS software.  Remote Desktop is preferred, either through a secure VPN, 
from another computer accessible from the Internet via Remote Desktop, or directly 
to the server. 

10. Create a folder on every web and process server to store the Synergy SIS software 
(generally called Edupoint Work Folder).  The database will be installed and setup 
when installing the first web server. 

11. Download the latest release from Edupoint FTP site to the Synergy SIS folder on 
every web and process server.  See the instructions later in this chapter on how to 
find and download the latest release. 

12. Extract the files from the downloaded ZIP file. 

 

Note – Many servers require user account access when extracting 
the installation files. You may need to do one of the following: 

• Add the Edupoint FTP site to your trusted sites in your 
browser. 

• Make sure that your user account setting allows changes and 
is unblocked. 

• Remove blocks from the ZIP file before unzipping it to an 
installation folder.   

Otherwise, the DLL files may be locked, which can cause application 
errors after the installation. 
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13. Decide if and where to install any auxiliary Synergy SIS software.  The table 
below outlines some recommendations, but most tools can be installed on any 
server. 
Software Description Location 
DB Tools Tool to manage the Synergy SIS 

database 
Web server 

Designer Tool to customize the Synergy SIS 
software – must be purchased separately 

Any workstation 

Generic Conversion Converts data from any file and imports it 
to the Synergy SIS database 

Process server 

ParentVUE & 
StudentVUE 

A web-based interface for parents & 
students to access Synergy SIS data 

Web server accessible to 
the Internet 

Photo Attach Imports photos to the Student screen Any workstation 
ST Dashboard Tool to install patches to Synergy SIS 

servers & monitor servers 
Process server 

ST Scanning Scans attendance and grading sheets 
and imports the data to Synergy SIS 

Any workstation 

SASI 3 Conversion Converts SASI XP data to Synergy SIS Process server 
SASI XP 
Conversion 

Converts SASI XP data to Synergy SIS Process server 

SIREN Custom report development software Any workstation 

14. Create a list of the following information (as applicable): 

• Server IP addresses and server names 

• Domain names and aliases used to access Synergy SIS 

• Load balancer IP 

• Admin login information for Synergy 

• SA login information for SQL Server 

• Rev login information for SQL Server 

• PVUE login information for SQL Server 

• VPN connection information, including connection method (Network 
Connection, VPN Client, Cisco AnyConnect, Forticlient, etc.) and login 
information for the server 

15. Print and review this Installation Guide. 
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.NET CONFIGURATION 
 
The current Synergy SIS release only works with .NET 4.0.  All web servers and process 
servers must be running .NET 4.0 before installing the software.  If .NET 4.0 is not already 
installed on these servers and set as the default .NET environment for the Default Website, 
.NET 4.0 must be installed and configured.  To install and configure .NET 4.0: 

1. On each server that will be a process server or web server, verify that at least 
Microsoft .NET Framework 1.1 is installed (or 2.0 for Windows 2008).  To verify the 
version of .NET installed on a Windows 2003-version server, go to Control Panel 
on the server and run Add/Remove Programs.  On a Windows 2008-version 
server, go to Control Panel on the server, and run Programs and Features.  If the 
server is completely up-to-date with all recommended updates from Microsoft, it will 
most likely have .NET 4.0 installed already. 

 
Figure 2.1 – Add/Remove Programs 

 
Figure 2.2 – Programs and Features 

Windows 2003 Windows 2008 

2. In the list of installed programs, look for Microsoft .NET Framework 1.1 or 2.0.  If 
version 4.0 is already installed, proceed to step 8 of these instructions to verify it has 
been set as the default for the website.  If the Microsoft .NET Framework 1.1 is not 
installed on Windows Server 2003, download and install it from the Microsoft 
website through either Windows Update or as a separate download.  .NET 2.0 can 
also be downloaded and installed at this time if desired.  .NET 4.0 may also be 
downloaded and installed through Windows Update if preferred. 

 

Note – Do not remove the .NET Framework 1.1 or 2.0 prior to 
installing version 4.0.  If the .NET Framework 2.0 is not installed, the 
.NET Framework 4.0 installer will download and install version 2.0 
prior to installing 4.0. 

3. Download the .NET 4.0 upgrade to each web server and process server.  The 
download can be obtained from the Microsoft website at  
http://www.microsoft.com/download/en/details.aspx?displaylang=en&id=17851. 

4. Run the file that was downloaded – different files will be downloaded depending on 
the version of Windows Server installed. 
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5. The Microsoft .NET Framework 4 Setup wizard will display.  Click the checkbox for I 
have read and accept the license terms.  Then click on the Install button. 

 
Figure 2.3 – Microsoft .NET Framework 4 Setup 

6. Continue to click Next until the installation is complete.  Leave all settings at the 
default choice. 

7. When the installation is complete, the Setup Complete window displays.  Click the 
Finish button to finish the installation. 

 
Figure 2.4 – Setup Complete 
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8. Next, each website must be set to use .NET 4.0 as the default.  To set the default 
.NET in use on the website when using IIS 6.0, go to Internet Information Service 
(IIS) Manager found under Control Panel > Administrative Tools on the server. 

9. Find the Default Web Site in the tree.  Right-click on the Default Web Site and 
select Properties.   

 
Figure 2.5 – IIS Manager 

Default .NET selected as part of 
installation process 

Windows 2003/IIS 6.0 Windows 2008/IIS 7.0 

10. Click on the ASP.NET tab.   

 
Figure 2.6 – Default Web Site Properties 

Default .NET selected as part of 
installation process 

Windows 2003/IIS 6.0 Windows 2008/IIS 7.0 
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11. Select 4.0.30319 from the ASP.NET version drop-down list.   

 
Figure 2.7 – ASP .NET Tab 

Default .NET selected as part of 
installation process 

Windows 2003/IIS 6.0 Windows 2008/IIS 7.0 

12. Click on the Apply button, then click the OK button.  Be sure to do this for each web 
server and process server to run Synergy SIS. 

 
  



System Installation Guide Chapter Two 
 

22 Copyright© 2013 Edupoint Educational Systems, LLC 
 

In Internet Information Services 7.0, the .NET 4.0 ISAPI filters also need to be set to 
allowed.  To configure these filters: 

1. Go to Internet Information Service (IIS) Manager, found under Administrative 
Tools on the server. 

2. Click on the Server Home page, and then double-click the ISAPI and CGI 
Restrictions. 

 
Figure 2.8 – IIS 7.0, Server Home Page 

3. Double-click on each of the two entries starting with ASP.NET v4.0. 

 
Figure 2.9 – IIS 7.0, ISAPI and CGI Restrictions 

4. Check the box Allow extension path to execute, and then click OK. 

 
Figure 2.10 – Edit ISAPI or CGI Restriction 
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DATABASE CONFIGURATION 
 
Synergy can be installed on SQL Server 2008 or Oracle 9i.  If the district uses Oracle 9i, 
please contact the Edupoint technical support team at support@edupoint.com or call for 
support at 1-877-899-9111 option 1 for specific instructions. 
 
When the web server software (ST) is installed, it also updates or setup the database.  If a 
database exists but has no tables, the installation process will create all tables and enter 
default data in the tables.  If a database exists, the installation process updates the 
database structure and updates the product-owned lookup tables. 
 
To configure the database prior to the software installation: 

1. Create the Synergy database. 

2. Create a login for a user account rev. 

3. Create the rev schema. 

Creating the Database 
To create the new Synergy database: 

1. In SQL Server Management Studio, expand the tree to find the Databases folder 
and right-click on the Databases folder. 

 
Figure 2.11 – SQL 2005/2008 Database Folder 

mailto:support@edupoint.com
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2. Select New Database…, and the New Database window pops-up. 

 
Figure 2.12 – SQL 2008 New Database  

3. Enter the Database Name.  The name should start with ST followed by the name of 
your district; for example, ST_Production, ST_Train, ST_Test, or ST_Demo.  Click 
the OK button, and the database will be created. 
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Adding a Login 
To create a login for the rev user: 

1. In SQL Server Management Studio (2008), expand the Security menu to find the 
Logins folder.  Right-click on the Logins folder and choose New Login. 

 
Figure 2.13 - SQL 2005/2008 Logins Folder  

2. The Login Properties window pops-up.  Enter a Login Name. Choose SQL Server 
Authentication, and enter a Password. For SQL 2008, uncheck Enforce 
Password Policy.  Change the Default Database to the ST database created 
earlier. 

 

Note – Edupoint provides a randomized Login Name and Password 
to the district in an Access document. 

 
Figure 2.14 – SQL 2008 Login – New 
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3. Click on the User Mapping option. 

 
Figure 2.15 – SQL 2008 User Mapping 

4. In the Database grid, check the name of the Synergy database (ST…) and enter 
the username rev.  In the Database roles for the selected database, check the 
db_owner role. 

5. Click the OK button on the dialog box. 
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Creating the Schema 
For SQL Server 2008, a new schema also needs to be created.   
 
To create a schema: 

1. In SQL Server Management Studio (2008), expand the tree to find the Schema 
folder (under Databases\STDatabase\Security\Schemas) and right-click on the 
Schema folder. 

 
Figure 2.16 – SQL 2008 Schemas Folder 

2. The Schema - New window pops-up.  Enter rev as the Schema Name and rev as 
the Schema Owner. 

 
Figure 2.17 – SQL 2005/2008 Schema – New Window 

3. Click the OK button, and the new schema is created. 
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Mapping the Schema to the User 
 
After the schema has been created, it needs to be assigned to the rev login.  To assign the 
schema to rev: 

1. In SQL Server Management Studio (2008), expand the tree to find the Logins 
folder (under the Security folder) and double-click on the Logins folder. 

 
Figure 2.18 – SQL 2008 Logins Folder 

2. Double-click on the rev icon.  The Login Properties windows pops-up.  

 
Figure 2.19 – SQL 2008 User Properties 
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3. Click on the User Mapping icon.  In the Default Schema field of the ST database, 
change the text from dbo to rev. 

 
Figure 2.20 – SQL 2008 User Mapping 

4.  Click the OK button.  

 
The database is now configured for the software installation. 
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OBTAINING THE LATEST RELEASE 
 
The latest release of the software is available on the Internet through the Edupoint FTP site 
at http://ftp.edupoint.com.  All Edupoint software is included in one compressed (ZIP) file.  
The entire ZIP file must be downloaded to install any software modules.  The latest release 
is found in the folder labeled _RELEASE.  Within this folder are subfolders with the version 
number of the release.  Be sure to download the ZIP file from the subfolder with the latest 
version number, as the previous release may be available in this folder as well. 

 

Note – Many servers require user account access when extracting 
the installation files. You may need to do one of the following: 

• Add the Edupoint FTP site to your trusted sites in your 
browser. 

• Make sure that your user account setting allows changes and 
is unblocked. 

• Remove blocks from the ZIP file before unzipping it to an 
installation folder.   

Otherwise, the DLL files may be locked, which can cause application 
errors after the installation. 

  

The ZIP file is generally around 1.75 gigabytes.  Edupoint 
recommends using one of the free FTP software tools to connect 
and download the software to ensure interrupted downloads can be 
resumed. 

 
To download the latest release: 

1. Connect to http://ftp.edupoint.com.  The website requires a username and 
password, which has been provided to your systems administrator. 

2. Open the _Release folder. 

 
Figure 2.21 – Release Folder 

http://ftp.edupoint.com/
http://ftp.edupoint.com/
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3. Open the folder of the most current release.  Note that there may be more than one 
release available.  The folders are named with the version of release.  For example, 
in the picture above you would select the 8.0.0.0 folder. 

4. Inside the release folder, there are three release note files. The 
X.X.X.X_ReleaseNotes.pdf file contains all the changes that are new in the current 
release.  The X.X.X.X_PreviouslyReleased_ReleaseNotes.pdf contains the notes 
for all the changes in the current release since the previous release.  The 
X.X.X.X_Gap_ReleaseNotes.pdf contains issues that have been released under the 
previous version but not the current version.  Any additional or updated 
documentation will also be contained in the release folder.  The ZIP files contain the 
software.  Starting with the November 2009 release, there are two zip files – ST64 
for 64-bit installation and ST for 32-bit. 

 
Figure 2.22 – RT Installers ZIP Files 

5. Choose the ZIP file to download, and download it to the computer. 

  

Tip:  Additional information that can be downloaded from the Edupoint 
FTP site includes: 

• _Documentation - includes all reference guides, quick reference 
cards, and technical notifications 

• _Release - includes the latest release and any patches, and the 
previous releases in an archive folder 

• _Training - includes the demo database, training manuals, and 
information from the user conferences. 

 
Each client also has a private folder where they can upload and 
download information specific to their district.  Each client folder has 
three subfolders: 

• Data - any customer-specific databases 

• Documentation - customer-specific guides or instructions 

• Patch - any patches specific to the district 
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OBTAINING THE LATEST UPDATE 
 
The latest update of the software is available on the Internet through the Edupoint FTP site 
at http://ftp.edupoint.com.  All Edupoint software is included in one (PKG) file.  The latest 
update is found in the folder labeled _RELEASE.  Within this folder are subfolders with the 
version number of the release.  Inside the folder of your version of the release is a folder 
labeled _Updates. Within this folder will be the folders containing individual updates.  The 
_Updates folder will contain the latest Continuous Enhancement and the latest Targeted 
Update (if any) that has been released after the CE. 
 
Updates to the software are released as Continuous Enhancements (CE) and Targeted 
Updates (TU). CE’s updates are represented by the third number of the release version 
number and TU’s are represented by the fourth number in the version number.  To apply a 
CE you must first install the release.  To apply a TU you must first install the release and 
apply the CE. For example, to apply the 7.5.10.0 CE you must first install the 7.5.0.0 
release, then upgrade to the 7.5.10.0 CE.  To apply the 7.5.10.13 TU, you must first apply 
install 7.5.0.0 release, then upgrade to the 7.5.10.0 CE, then upgrade to the 7.5.10.13 TU. 

 

Note – Many servers require user account access when extracting 
the installation files. You may need to do one of the following: 

• Add the Edupoint FTP site to your trusted sites in your 
browser. 

• Make sure that your user account setting allows changes and 
is unblocked. 

• Remove blocks from the ZIP file before unzipping it to an 
installation folder.   

Otherwise, the DLL files may be locked, which can cause application 
errors after the installation. 

  
Edupoint recommends using one of the free FTP software tools to 
connect and download the software to ensure interrupted 
downloads can be resumed. 

 
To download the latest update: 

http://ftp.edupoint.com/
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6. Connect to http://ftp.edupoint.com.  The website requires a username and 
password, which has been provided to your systems administrator. 

7. Open the _Release folder. 

 
Figure 2.23 – Release Folder 

8. Open the folder of your current release.  Note that there may be more than one 
release available.  The folders are named with the version of release.  For example, 
in the picture above you would select the 20111221_Release_7.5.0 folder. 

9. Open the folder of the update to apply.  Note that there may be more than one 
update available. The folders are named with the version of the release. For 
example, in the picture below, you would select the 20130228_TU_7.5.10.13 folder. 

 
Figure 2.24 –Update Folder 

http://ftp.edupoint.com/
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10. Inside the release folder, there are at least two files.  The PDF file contains the 
release notes for this version of the software, which outlines all of the changes since 
the last release.  The PKG file contains the update to the software.  This folder may 
also contain updates to offline applications as well as any additional or updated 
documentation. 

 
Figure 2.25 – RT Installers ZIP Files 

11. Choose the PKG file to download, and download it to the computer. 

  

Tip:  Additional information that can be downloaded from the Edupoint 
FTP site includes: 

• _Documentation - includes all reference guides, quick reference 
cards, and technical notifications 

• _Release - includes the latest release and any patches, and the 
previous releases in an archive folder 

• _Training - includes the demo database, training manuals, and 
information from the user conferences. 

 
Each client also has a private folder where they can upload and 
download information specific to their district.  Each client folder has 
three subfolders: 

• Data - any customer-specific databases 

• Documentation - customer-specific guides or instructions 

• Patch - any patches specific to the district 
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INSTALLING THE DEMO DATABASE (OPTIONAL) 
 
A database for Synergy SIS is available with demo data that can be used for training, 
testing and demonstration purposes.  To install the demo database: 

1. Download the desired demo data ZIP file from the _Training\DemoData folder on 
Edupoint’s FTP site.  The ZIP file contains two files:  the demo database and the 
‘revuser’ SQL Query.  

 
Figure 2.26 – Downloading the Demo Database 

2. Extract the files to a folder on the database server. 

3. Create a new database for the demo data following the instructions in the Creating 
the Database section earlier in this chapter.  It is recommended to name the 
database STDemo. 

4. In the Security\Logins folder, right-click on the rev account and select Properties.   

5. The software displays the SQL Server Login Properties dialog box. Click the User 
Mapping option.   

 
Figure 2.27 – User Mapping 
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6. Check the demo database STDemo, then check the db_owner role below.  

7. Click the OK button. 

8. Create a rev schema for the new demo database and map the schema to the rev 
user, as outlined in the Creating the Schema and Mapping the Schema to the User 
sections earlier in this chapter. 

9. Import the demo database by restoring it as if from a backup.  To restore the 
database, right-click on the demo database and select Tasks>Restore>Database. 

10. The Restore Database window pops-up. Click on the From device option, then click 
on the  button to find the extracted file. 

 
Figure 2.28 – Restore Database 

11. Once the file is listed, check the Restore box. 
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12. Click on the Options page, and check the box to Overwrite the existing database. 

 
Figure 2.29 – Restore Database, Options 

13. Click the OK button, and the data will be imported. 

14. Run the RestoreRevUser SQL Query to remap the rev logon to the database.  To 
run the query, click on File…Open in SQL Server Management Studio.  Find the file 
and click on it to open. 

 
Figure 2.30 – Running the RestoreRevUser Query 

15. Once the query is open, change the database name to STDemo from the drop-
down list. 

16. Click the Execute exclamation mark icon in the toolbar to run the query.  

17. When the query has finished, close SQL Server Management Studio and the demo 
database should be ready for the software installation.  
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RECOMMENDED WORKSTATION CONFIGURATION 
 
For districts using Internet Explorer, the following settings should be adjusted for optimal 
performance: 

1. Disable all extra toolbars, such as the Google toolbar or Bing toolbar. 

2. Disable pop-up blockers for the Synergy website. 

3. In the Security settings, enable File Download and Automatic prompting for file 
downloads to allow the export of Excel files. 

4. On the Advanced tab, uncheck Use HTTP 1.1 and Use HTTP 1.1 through proxy 
connections. 

 
For districts planning to use the Class Board tool in Mass Scheduling, Microsoft Silverlight 
must be installed on the workstation.  To install Silverlight, use the Windows Update tool. 
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Chapter Three: 
NEW INSTALLATION 

 
 
 
 
 
 
 
 
 
 
 
 

In this chapter, the following topics are covered: 
► How to install one or more web servers 
► How to install one or more process servers 
► How to setup a server for testing or training 
► How to install Synergy in a 64-bit environment 
► How to install other Synergy software 
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WEB SERVER INSTALLATION 
 
The web server will be the front-end to the Synergy installation, and must be accessible as 
a web server to everyone who needs to access the Synergy software.  Users will access 
the software via their web browser by pointing to the default site address on this server.   
 
The web server software is installed as the Default Web Site on the server.  This cannot be 
changed.  The ST Dev software can be used to install the Synergy software to a different 
directory to setup development, test and training environments. 
 
The web server software installation not only installs the software for the web server, but it 
also installs the database for the Synergy installation. 
 
These instructions are for 32-bit environments.  For instructions on how to install the 
software in a 64-bit environment, please see the section later in this chapter on 64-bit 
Software Installations. 
 
To install the web server software: 

1. Find the folder on the server where the Synergy release file has been extracted, as 
outlined in Chapter Two of this guide. 

2. In the folder, find the SynergyWebSetup folder.  Expand this folder to find and open 
the Pre sub-folder. 

3. In the Pre sub-folder, double-click the InstallUserPrompt.exe file. 

 
Figure 3.1 – Pre Folder, InstallUserPrompt.exe 
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4. The software displays the Welcome dialog box.  Click the Next button. 

 
Figure 3.2 – Install Wizard Dialog Box 

5. The software displays the Install Wizard Step 1: License Key dialog box.  Enter the 
Organization Name, Localization and License Key information received from 
Edupoint.  This information is e-mailed to the district following the purchase of the 
software.  Click the Next button to continue the installation. 

 
Figure 3.3 – Install Wizard Step 1: License Key Dialog Box 
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6. The Install Wizard Step 2:  Install Type dialog box appears next.  Choose First Web 
Server + Database to install Synergy for the first time.  If there will be additional 
web servers installed to handle the user load, check the box Server is a member of 
a web farm. 

 
Figure 3.4- Install Wizard Step 2: Install Type Dialog Box 

7. If the Server is a member of a web farm box has been checked, also select the IP 
address from the drop-down list that will be used to communicate with the other 
web servers.  If the server has multiple network cards, choose the IP address for the 
private LAN.  Then click Next. 

 
Figure 3.5 – Install Wizard Step 2:  Install Type Dialog Box, IP Address 
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8. The software displays the Install Wizard Step 3:  Database Settings dialog box.  
Choose the type of database used for the Synergy SIS installation - either the 
Microsoft SQL Server 2000+ database or Oracle 9i database.  Then enter the 
values for each type of database as outlined below. 

For SQL Server 2000+ For Oracle 9i 

 
Figure 3.6 – Install Wizard Step 3:  Database Settings 

Dialog Box, SQL 

 
Figure 3.7 – Install Wizard Step 3:  Database Settings Dialog 

Box, Oracle 

• Enter the server name or TCP/IP 
address in the Database Server 
Name field. 

• Enter the Database Name in 
Database Name field. 

• Enter rev in the User ID field, the 
Password and Confirm Password 
fields. 

• Enter the server name or TCP/IP 
address in the Database Server 
Name field. 

• Enter rev in the User ID field, the 
Password and Confirm Password 
fields. 

9. Click the Test Database Connection button. The software displays the Connection 
Succeeded dialog box if the settings are entered correctly.  Click OK to continue, 
and then click the Next button on the Install Wizard dialog box. 

 
Figure 3.8 – Connection Succeeded Dialog Box. 



System Installation Guide Chapter Three 
 

44 Copyright© 2013 Edupoint Educational Systems, LLC 
 

10. The software displays the Finish dialog box.  Click the Finish button. 

 
Figure 3.9 – Finish Dialog Box 

11. The following web site warning dialog box may appear if other websites are setup by 
default on the web server. To overwrite the existing website on port 80, click OK.  
Otherwise, cancel the installation and move the existing website on port 80 to a 
different port or remove it from the server, and then restart the installation. 

 
Figure 3.10 – Web Site Warning Dialog Box 

12. The software displays the Welcome to the ST Setup Wizard dialog box.  Click the 
Next button. 

 
Figure 3.11 - Welcome to the ST 32 Web Setup Wizard dialog box 
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13. The software displays the Confirm Installation dialog box.  Click the Next button. 

 
Figure 3.12 - Confirm Installation dialog box 

14. The software displays the Installing ST dialog box as the web server software is 
installed.  A progress bar will indicate the progression of the installation.  

 
Figure 3.13 - Installing ST dialog box 
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15. During this process, the software also displays the Updating Database dialog box as 
the database is installed.  A progress bar will indicate the progression of the 
database installation. 

 
Figure 3.14 - Updating Database dialog box 

16. Please wait for both of these processes to complete.  Once complete, the software 
displays the Installation Complete dialog box.  Click the Close button. 

 
Figure 3.15 - Installation Complete dialog box 

 
The web server software and the database are now installed!  Additional web servers may 
now be installed.  The process server should also be installed, as well as any other Synergy 
software as outlined in the sections later in this chapter. 
 

  

Note:  All Synergy modules must be uninstalled and reinstalled with 
each new release, as the core software that each module uses is 
updated each time.  However, the settings entered during installation 
are saved so the information will not need to be re-entered during a re-
install (for example, the license key is saved).  For instructions on 
upgrading to a new release, please see Chapter Four. 
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To install additional web servers in a server web farm: 

1. Find the folder on the server where the Synergy release file has been extracted, as 
outlined in Chapter Two of this guide. 

2. In the folder, find the SynergyWebSetup folder.  Expand this folder to find and open 
the Pre sub-folder. 

3. In the Pre sub-folder, double-click the InstallUserPrompt.exe file. 

Figure 3.16 – Pre Folder, InstallUserPrompt.exe 

4. The software displays the Welcome dialog box.  Click the Next button. 

 
Figure 3.17 – Install Wizard Dialog Box 
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5. The software displays the Install Wizard Step 1: License Key dialog box.  Enter the 
Organization Name, Localization and License Key information received from 
Edupoint.  This information is e-mailed to the district following the purchase of the 
software.  Click the Next button to continue the installation. 

 
Figure 3.18 – Install Wizard Step 1: License Key Dialog Box 

6. The Install Wizard Step 2:  Install Type dialog box appears next.  Choose 
Additional Web Server (Web Farm Servers 2+) to install Synergy on another web 
server.  Check the box Server is a member of a web farm, and select the IP 
address from the drop-down list that will be used to communicate with the other 
web servers.  If the server has multiple network cards, choose the IP address for the 
private LAN.  Then click Next. 

 
Figure 3.19- Install Wizard Step 2: Install Type Dialog Box 
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7. The software displays the Install Wizard Step 3:  Database Settings dialog box.  
Choose the type of database used for the Synergy installation - either the Microsoft 
SQL Server 2000+ database or Oracle 9i database.  Then enter the values for each 
type of database as outlined below. 

For SQL Server 2000+ For Oracle 9i 

 
Figure 3.20 – Install Wizard Step 3:  Database Settings 

Dialog Box, SQL 

 
Figure 3.21 – Install Wizard Step 3:  Database Settings 

Dialog Box, Oracle 

• Enter the server name or TCP/IP 
address in the Database Server 
Name field. 

• Enter the Database Name in 
Database Name field. 

• Enter rev in the User ID field, the 
Password and Confirm Password 
fields. 

• Enter the server name or TCP/IP 
address in the Database Server 
Name field. 

• Enter rev in the User ID field, the 
Password and Confirm Password 
fields. 

8. Click the Test Database Connection button. The software displays the Connection 
Succeeded dialog box if the settings are entered correctly.  Click OK to continue, 
and then click the Next button on the Install Wizard dialog box. 

 
Figure 3.22 – Connection Succeeded Dialog Box. 
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9. The software displays the Finish dialog box.  Click the Finish button. 

 
Figure 3.23 – Finish Dialog Box 

10. The following web site warning dialog box may appear if other websites are setup by 
default on the web server. To overwrite the existing website on port 80, click OK.  
Otherwise, cancel the installation and move the existing website on port 80 to a 
different port or remove it from the server, and then restart the installation. 

 
Figure 3.24 – Web Site Warning Dialog Box 

11. The software displays the Welcome to the ST 32 Web 1 Setup Wizard dialog box.  
Click the Next button. 

 

 
Figure 3.25 - Welcome to the ST 32 Web 1 Setup Wizard dialog box 



Chapter Three System Installation Guide 
 

Copyright© 2013 Edupoint Educational Systems, LLC 51 
 

 

12. The software displays the Confirm Installation dialog box.  Click the Next button. 

 

 
Figure 3.26 – Confirm Installation dialog box 

13. The software displays the Installing ST dialog box as the web server software is 
installed.  A progress bar will indicate the progression of the installation.  

 
Figure 3.28 - Installing ST 32 Web 1 dialog box 
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14. Please wait for this process to complete.  Once complete, the software displays the 
Installation Complete dialog box.  Click the Close button. 

 
Figure 3.29 - Installation Complete dialog box 

 
The additional web server is now installed!  Repeat steps 1 through 14 to install each 
additional web server. 
 
 

  

Tip:  To make the website easier to locate by staff, the district may want 
to create an alias for the location of the Synergy website in their DNS 
settings. 
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PROCESS SERVER INSTALLATION 
 
The process server handles report processing and other intensive processing tasks to 
improve the performance of the web front-end servers.  Follow the steps below to install 
each process server in use at the district.  Process servers can be dedicated to an 
organization like a school or group of schools, or to certain types of processing tasks.  To 
install a process server: 

1. Find the folder on the server where the Synergy SIS release file has been extracted, 
as outlined in Chapter Two of this guide 

2. In the latest release folder, find the SynergyProcessServiceSetup folder and 
double-click on the Setup.exe file. 

 
Figure 3.30 – SynergyProcessServiceSetup Folder 

3. If Microsoft Visual C++ 2010 x86 Redistributable has already been installed, 
continue to the next step. If it has not yet been installed, the software displays a 
dialog to install Visual C++ 2010 Runtime Libraries (x86). Follow the prompts to 
download and install the software.  

 
Figure 3.31 - Install Visual C++ 2010 Runtime Libraries (x86) dialog box 
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4. The software displays the Welcome to the ST Process Service Setup Wizard dialog 
box.  Click the Next button to continue. 

 
Figure 3.31 - Welcome to the ST Process Service Setup Wizard dialog box 

5. The software displays the Select Installation Folder dialog box.  To change the 
default installation location (which is C:\Program Files\Edupoint\RT Process Service, 
either type the new location in the Folder box or click the Browse button to locate 
the new folder.  To see what space the software will take on the drive, click the Disk 
Cost button. 

  
Figure 3.32 - Select Installation Folder dialog box 
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6. Select the Everyone radio button to make the process server available for all server 
logons, or click Just me to install only for the currently logged in user.  Click the 
Next button to continue. 

7. The software displays the Confirm Installation dialog box.  Click the Next button to 
start the installation. 

  
Figure 3.263 - Confirm Installation dialog box 

8. The Installing RT Process Service dialog box is displayed, with a progress bar to 
show the progress of the installation. 

 
Figure 3.34 - Installing ST Process Service dialog box 
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9. When the installation is complete, the Installation Complete dialog box is displayed. 
Click the Close button to finish the installation. 

  
Figure 3.35 - Installation Complete dialog box 

 
The process server is now installed.  
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TEST/TRAINING SERVER INSTALLATION 
 
In addition to installing a production version of Synergy, additional copies of Synergy may 
be installed to create a testing platform or to be used for training.  These installations 
contain the exact same software as the production version, but they can be installed to a 
different location so as not to overwrite the Default Web Site.  To install a test version of the 
software: 

1. Find the folder on the server where the Synergy release file has been extracted, as 
outlined in Chapter Two of this guide. 

2. In the folder, find the SynergyWebSetup1 folder. Expand this folder to find and 
open the Pre sub-folder. 

3. In the Pre sub-folder, double-click the InstallUserPrompt.exe file. 

 
Figure 3.36 – Synergy64WebSetup1 Folder 

4. The software displays the Welcome dialog box.  Click the Next button. 

  
Figure 3.37 – Install Wizard Dialog Box 
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5. The software displays the Install Wizard Step 1: License Key dialog box.  Confirm 
the license key information, and click the Next button to continue the installation. 

  
Figure 3.38 – Install Wizard Step 1: License Key Dialog Box 

6. The Install Wizard Step 2:  Install Type dialog box appears next.  Choose First Web 
Server + Database to install the development server, and then click Next. 

  
Figure 3.27- Install Wizard Step 2: Install Type Dialog Box 
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7. The software displays the Install Wizard Step 3:  Database Settings dialog box.  
Choose the type of database used for the Synergy SIS installation - either the 
Microsoft SQL Server 2000+ database or Oracle 9i database.  Then enter the 
values for each type of database as outlined below. 

For SQL Server 2000+ For Oracle 9i 

 
Figure 3.28 – Install Wizard Step 3:  Database Settings 

Dialog Box, SQL 

  
Figure 3.29 – Install Wizard Step 3:  Database Settings 

Dialog Box, Oracle 

• Enter the server name or TCP/IP 
address in the Database Server 
Name field. 

• Enter the Database Name in 
Database Name field. 

• Enter rev in the User ID field, the 
Password and Confirm Password 
fields. 

• Enter the server name or TCP/IP 
address in the Database Server 
Name field. 

• Enter rev in the User ID field, the 
Password and Confirm Password 
fields. 

 

  

Caution:  Be sure to enter the name of a different database such as 
ST_Demo or ST_Test so that this installation does not modify the main 
production database. 

 

8. Click the Test Database Connection button. The software displays the Connection 
Succeeded dialog box if the settings are entered correctly.  Click OK to continue, 
and then click the Next button on the Install Wizard dialog box. 

 
Figure 3.30 – Connection Succeeded Dialog Box. 
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9. The software displays the Finish dialog box.  Click the Finish button. 

 
Figure 3.31 – Finish Dialog Box 

10. The following web site warning dialog box may appear if other websites are setup by 
default on the web server. To overwrite the existing website on port 80, click OK.  
Otherwise, cancel the installation and move the existing website on port 80 to a 
different port or remove it from the server, and then restart the installation. 

 
Figure 3.32 – Web Site Warning Dialog Box 

11. The software displays the Welcome to the RT_Developer Setup Wizard dialog box.  
Click the Next button. 

  
Figure 3.33 - Welcome to the ST 32 Web 1Setup Wizard dialog box 
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12. The software displays the Select Installation Address dialog box.  Enter the name of 
the Virtual directory (underneath the root web server directory) where the software 
should be installed.  To check the disk space available, click the Disk Cost button.  
To select a different Application Pool, select the new Application Pool from the 
dropdown.  After all the settings have been configured, click the Next button. 

  
Figure 3.34 - Select Installation Address dialog box 

 

 

Note – Edupoint recommends using separate Application Pools for 
each webserver (Production, Training, Test, and Demo.) This enables 
better control and troubleshooting of web server issues. 
 
In addition, we recommend setting up the Application Pools to recycle 
at a specific time instead of after a number of cycles.  This prevents 
the Application Pool from resetting during school hours.   
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13. The software displays the Confirm Installation dialog box.  Click the Next button. 

  
Figure 3.35 - Confirm Installation dialog box 
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14. The software displays the Installing ST 32 Web 1 dialog box as the web server 
software is installed.  A progress bar will indicate the progression of the installation.  

 
Figure 3.36 - Installing ST 32 Web 1 dialog box 

15. During this process, the software also displays the Updating Database dialog box as 
the database is installed.  A progress bar will indicate the progression of the 
database installation. 

 
Figure 3.37 - Updating Database dialog box 
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16. Please wait for both of these processes to complete.  Once complete, the software 
displays the Installation Complete dialog box.  Click the Close button. 

  
Figure 3.38 - Installation Complete dialog box 

 
The test or training server installation is now complete!  To install another instance of the 
Synergy software for testing or training, there are 3 other folders that can be used to install 
another instance of the software: SynergyWebSetup2, SynergyWebSetup3 and 
SynergyWebSetup4.  This allows for up to 5 instances of Synergy to be installed on one 
server – 1 production copy (SynergyWebSetup) and 4 development copies 
(SynergyWebSetup1-4). 
 

 
Figure 3.39 – STWebSetup Folders 

 
 

64-BIT SOFTWARE INSTALLATION 
 
If installing Synergy SIS on a 64-bit operating system, the 64-bit version of Synergy SIS 
must be installed.  To install the 64-bit version of the web server software: 

1. When downloading the ZIP file with the latest release as outlined in the section 
Obtaining the Latest Release in Chapter Two of this guide, be sure to download the 
ZIP file titled RT64 instead of RT. 

2. Extract the ZIP file to the folder on the server used for Synergy SIS software 
installation, as outlined in Chapter Two of this guide. 

3. In the folder, find the RT64Setup folder.  Expand this folder to find and open the Pre 
sub-folder. 
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4. In the Pre sub-folder, double-click the InstallUserPrompt.exe file. 

 
Figure 3.40 – Pre Folder, InstallUserPrompt.exe 

5. The software displays the Welcome dialog box.  Click the Next button. 

 
Figure 3.41 – Install Wizard Dialog Box 
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6. The software displays the Install Wizard Step 1: License Key dialog box.  Enter the 
Organization Name, Localization and License Key information received from 
Edupoint.  This information is e-mailed to the district following the purchase of the 
software.  Click the Next button to continue the installation. 

 
Figure 3.42 – Install Wizard Step 1: License Key Dialog Box 

7. The Install Wizard Step 2:  Install Type dialog box appears next.  Choose First Web 
Server + Database to install Synergy SIS for the first time.  If there will be additional 
web servers installed to handle the user load, check the box Server is a member of 
a web farm. 

 
Figure 3.43- Install Wizard Step 2: Install Type Dialog Box 
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8. If the Server is a member of a web farm box has been checked, also select the IP 
address from the drop-down list that will be used to communicate with the other 
web servers.  If the server has multiple network cards, choose the IP address for the 
private LAN.  Then click Next. 

 
Figure 3.44 – Install Wizard Step 2:  Install Type Dialog Box, IP Address 

9. The software displays the Install Wizard Step 3:  Database Settings dialog box.  
Choose the type of database used for the Synergy SIS installation - either the 
Microsoft SQL Server 2000+ database or Oracle 9i database.  Then enter the 
values for each type of database as outlined below. 

For SQL Server 2000+ For Oracle 9i 

 
Figure 3.45 – Install Wizard Step 3:  Database Settings 

Dialog Box, SQL 

 
Figure 3.46 – Install Wizard Step 3:  Database Settings 

Dialog Box, Oracle 

• Enter the server name or TCP/IP 
address in the Database Server 
Name field. 

• Enter the Database Name in 
Database Name field. 

• Enter rev in the User ID field, the 
Password and Confirm Password 
fields. 

• Enter the server name or TCP/IP 
address in the Database Server 
Name field. 

• Enter rev in the User ID field, the 
Password and Confirm Password 
fields. 
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10. Click the Test Database Connection button. The software displays the Connection 
Succeeded dialog box if the settings are entered correctly.  Click OK to continue, 
and then click the Next button on the Install Wizard dialog box. 

 
Figure 3.47 – Connection Succeeded Dialog Box. 

11. The software displays the Finish dialog box.  Click the Finish button. 

 
Figure 3.48 – Finish Dialog Box 

12. The following web site warning dialog box may appear if other websites are setup by 
default on the web server. To overwrite the existing website on port 80, click OK.  
Otherwise, cancel the installation and move the existing website on port 80 to a 
different port or remove it from the server, and then restart the installation. 

 
Figure 3.49 – Web Site Warning Dialog Box 
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13. The software displays the Welcome to the ST Setup Wizard dialog box.  Click the 
Next button. 

 
Figure 3.50 - Welcome to the ST 64 Web Setup Wizard dialog box 

14. The Select Installation Address dialog box displays.  Select the website on which to 
install the Synergy SIS software from the Site drop-down list, and select the 
ASP.NET v4.0 application pool to use from the Application Pool drop-down list.  
To install it as the root of the website selected, leave the Virtual Directory box 
blank.  It can also be installed in a subdirectory of the root by entering a new Virtual 
Directory name.  To see what space it will take on the server, click the Disk Cost 
button.  When finished configuring the installation, click Next. 

  
Figure 3.51 - Select Installation Address dialog box 
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15. The software displays the Confirm Installation dialog box.  Click the Next button. 

16. The software displays the Installing RT dialog box as the web server software is 
installed.  A progress bar will indicate the progression of the installation.  

 
Figure 3.52 - Installing ST 64 Web dialog box 

17. During this process, the software also displays the Updating Database dialog box as 
the database is installed.  A progress bar will indicate the progression of the 
database installation. 

 
Figure 3.53 - Updating Database dialog box 
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18. Please wait for both of these processes to complete.  Once complete, the software 
displays the Installation Complete dialog box.  Click the Close button. 

 
Figure 3.54 - Installation Complete dialog box 

 
The web server software and the database are now installed!  Additional web servers may 
now be installed as outlined below.  The 64-bit process server should also be installed, as 
well as any other Synergy software as outlined in the sections later in this chapter. 
 
To install additional web servers: 

1. Find the folder on the server where the Synergy SIS release file has been extracted, 
as outlined in Chapter Two of this guide. 

2. In the folder, find the Synergy64WebSetup1 folder.  Expand this folder to find and 
open the Pre sub-folder. 

3. In the Pre sub-folder, double-click the InstallUserPrompt.exe file. 

 
Figure 3.55 – Pre Folder, InstallUserPrompt.exe 
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4. The software displays the Welcome dialog box.  Click the Next button. 

 
Figure 3.56 – Install Wizard Dialog Box 

5. The software displays the Install Wizard Step 1: License Key dialog box.  Enter the 
Organization Name, Localization and License Key information received from 
Edupoint.  This information is e-mailed to the district following the purchase of the 
software.  Click the Next button to continue the installation. 

 
Figure 3.57 – Install Wizard Step 1: License Key Dialog Box 
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6. The Install Wizard Step 2:  Install Type dialog box appears next.  Choose 
Additional Web Server (Web Farm Servers 2+) to install Synergy SIS on another 
web server.  Check the box Server is a member of a web farm, and select the IP 
address from the drop-down list that will be used to communicate with the other 
web servers.  If the server has multiple network cards, choose the IP address for the 
private LAN.  Then click Next. 

 
Figure 3.58- Install Wizard Step 2: Install Type Dialog Box 
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7. The software displays the Install Wizard Step 3:  Database Settings dialog box.  
Choose the type of database used for the Synergy SIS installation - either the 
Microsoft SQL Server 2000+ database or Oracle 9i database.  Then enter the 
values for each type of database as outlined below. 

For SQL Server 2000+ For Oracle 9i 

 
Figure 3.59 – Install Wizard Step 3:  Database Settings 

Dialog Box, SQL 

 
Figure 3.60 – Install Wizard Step 3:  Database Settings 

Dialog Box, Oracle 

• Enter the server name or TCP/IP 
address in the Database Server 
Name field. 

• Enter the Database Name in 
Database Name field. 

• Enter rev in the User ID field, the 
Password and Confirm Password 
fields. 

• Enter the server name or TCP/IP 
address in the Database Server 
Name field. 

• Enter rev in the User ID field, the 
Password and Confirm Password 
fields. 

8. Click the Test Database Connection button. The software displays the Connection 
Succeeded dialog box if the settings are entered correctly.  Click OK to continue, 
and then click the Next button on the Install Wizard dialog box. 

 
Figure 3.61 – Connection Succeeded Dialog Box. 
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9. The software displays the Finish dialog box.  Click the Finish button. 

 
Figure 3.62 – Finish Dialog Box 

10. The following web site warning dialog box may appear if other websites are setup by 
default on the web server. To overwrite the existing website on port 80, click OK.  
Otherwise, cancel the installation and move the existing website on port 80 to a 
different port or remove it from the server, and then restart the installation. 

 
Figure 3.63 – Web Site Warning Dialog Box 

11. The software displays the Welcome to the RT Setup Wizard dialog box.  Click the 
Next button. 

 
Figure 3.64 - Welcome to the ST 64 Web 1 Setup Wizard dialog box 
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12. The Select Installation Address dialog box displays.  Select the website on which to 
install the Synergy SIS software from the Site drop-down list, and select the 
ASP.NET v4.0 application pool to use from the Application Pool drop-down list.  
To install it as the root of the website selected, leave the Virtual Directory box 
blank.  It can also be installed in a subdirectory of the root by entering a new Virtual 
Directory name.  To see what space it will take on the server, click the Disk Cost 
button.  When finished configuring the installation, click Next. 

  
Figure 3.65 - Select Installation Address dialog box 

13. The software displays the Confirm Installation dialog box.  Click the Next button. 

 
Figure 3.66 - Confirm Installation dialog box 
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14. The software displays the Installing ST dialog box as the web server software is 
installed.  A progress bar will indicate the progression of the installation.  

 
Figure 3.67 - Installing ST 64 Web 1 dialog box 

15. Please wait for this process to complete.  Once complete, the software displays the 
Installation Complete dialog box.  Click the Close button. 

 
Figure 3.68 - Installation Complete dialog box 

The additional web server is now installed!  Repeat steps 1 through 15 to install each 
additional web server. 
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To install the 64-bit process server: 

1. Find the folder on the server where the Synergy release file has been extracted, as 
outlined in Chapter Two of this guide. 

2. In the latest release folder, find the RT64ProcessServiceSetup folder and right-
click on the Setup.exe file. Select Run as administrator. 

 
Figure 3.69 – Synergy64ProcessServiceSetup Folder 

3. If Microsoft Visual C++ 2010 x86 Redistributable has already been installed, 
continue to the next step. If it has not yet been installed, the software displays a 
dialog to install Visual C++ 2010 Runtime Libraries (x86). Follow the prompts to 
download and install the software. 

 
Figure 3.70 – Install Visual C++ 2010 Runtime Libraries (x86) dialog box 
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4. The software displays the Welcome to the RT Process Service Setup Wizard dialog 
box.  Click the Next button to continue. 

 
Figure 3.71 - Welcome to the ST Process Service Setup Wizard dialog box 
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5. The software displays the Select Installation Folder dialog box.  To change the 
default installation location (which is C:\Program Files\Edupoint\RT Process Service, 
either type the new location in the Folder box or click the Browse button to locate 
the new folder.  To see what space the software will take on the drive, click the Disk 
Cost button. 

 
Figure 3.72 - Select Installation Folder dialog box 

6. Select the Everyone radio button to make the process server available for all server 
logons, or click Just me to install only for the currently logged in user.  Click the 
Next button to continue. 

7. The software displays the Confirm Installation dialog box.  Click the Next button to 
start the installation. 

 
Figure 3.73 - Confirm Installation dialog box 
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8. The Installing ST Process Service dialog box is displayed, with a progress bar to 
show the progress of the installation. 

 
Figure 3.74 - Installing ST Process Service dialog box 

9. When the installation is complete, the Installation Complete dialog box is displayed. 
Click the Close button to finish the installation. 

 
Figure 3.75 - Installation Complete dialog box 

 
The process server is now installed. For information on starting and configuring the process 
server, please see the chapter on the ST Process Server in the Synergy SIS – System 
Administrator Guide. 
 
All other 64-bit software is installed in the same manner as the 32-bit software, but using 
the software from the ST64_installers ZIP file instead. 
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OTHER Synergy SIS SOFTWARE INSTALLATION 
 
The other software tools that can be installed with Synergy SIS are: 

• DB Tools - Tool to manage the Synergy SIS database 

• Designer - Tool to customize the Synergy SIS software – must be purchased 
separately- 

• Generic Conversion - Converts data from any file and imports it to the Synergy SIS 
database 

• ParentVUE & StudentVUE - A web-based interface for parents & students to 
access Synergy SIS data 

• Photo Attach - Imports photos to the Student screen 

• ST Dashboard - Tool to install patches to Synergy SIS servers & monitor servers 

• ST Scanning - Scans attendance and grading sheets and imports the data to 
Synergy SIS 

• SASI 3 Conversion - Converts SASI XP data to Synergy SIS 

• SASI XP Conversion - Converts SASI XP data to Synergy SIS 

• SIREN - Custom report development software 

 
The instructions for installing each of these tools can be found in the following guides: 
 

Software Guide 
DB Tools  Synergy SIS - System Administrator Guide 
Designer  Revelation Technology Guide 
Generic Conversion  Synergy SIS - Generic Conversion Guide 
ParentVUE & StudentVUE ParentVUE & StudentVUE Administrator Guide 
Photo Attach  Synergy SIS -Student Information Administrator Guide 
ST Dashboard  Chapter Five of this guide 
ST Scanning  Synergy SIS - Student Information Administrator Guide 
SASI 3 Conversion  Synergy SIS -SASI Conversion Guide 
SASI XP Conversion  Synergy SIS -SASI Conversion Guide 
SIREN  Synergy SIS - SIREN Guide 
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Chapter Four: 
UPGRADE TO A NEW RELEASE 

 
 
 
 
 
 
 
 
 
 
 
 

In this chapter, the following topics are covered: 
► How to upgrade to a new release 
► The recommended steps in installing a new release 
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UPGRADE CHECKLIST 
 
Edupoint issues upgrades or new releases of the Synergy SIS software twice a year, 
generally in July and January.  The upgrades are provided free of charge to all current 
customers, and there are no additional upgrade costs.  In between these major releases, 
patches may be available.  For instructions on how to install patches, please see Chapter 
Five. 
 
To install a new release: 

 Download the new release. 

 Install the new release as a test system & test all functionality. 

 Turn off access to the system. 

 Backup the database.  Also, back up the web server (optional). 

 Uninstall the process servers 

 Uninstall all other Synergy SIS software (scanning, DBTools, etc.) 

 Uninstall the web servers 

 Install the new release 

 
Detailed instructions for each of these steps can be found in the sections of this chapter. 
 
 

DOWNLOAD THE NEW RELEASE 
 
To download the new release, follow the steps in the section titled Obtaining the Latest 
Release in Chapter Two of this guide.  Each release also has a PDF outlining the changes 
in the latest release.  Be sure to read the PDF to see what changes may affect the district, 
and prepare instructions for the end users on any new functionality. 
 
 

INSTALL A TEST VERSION 
 
Install a test version of the new release as outlined in the section titled Test/Training Server 
Installation in Chapter Three of this guide.  Before installing the test version, any test 
version of Synergy SIS web servers or process servers on the test server(s) must be 
uninstalled as outlined in the sections Uninstall the Web Server or Uninstall the Process 
Server later in this chapter.  The process server used with the test version must be from the 
same release as the web server software. 
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TURN OFF ACCESS 
 
Before beginning the upgrade process, access to the Synergy SIS software for end users 
should be turned off.  If using LDAP integration, an easy way to remove access for end 
users but keep all systems up and running is to turn off LDAP integration on the System 
Configuration screen of Synergy SIS.  Since users will not know their native Synergy SIS 
password, this effectively locks them out of the system.  Be sure the administrator(s) of 
the system do know the native Synergy SIS password for the admin logon for the 
district’s Synergy SIS system.  To turn off LDAP integration: 

1. Go to the System Configuration screen, found under Synergy SIS > System > 
Setup. 

 
Figure 4.1 – System Configuration Screen 

2. Uncheck the box labeled Using LDAP. 

3. Click the Save button at the top of the screen. 
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If not using LDAP integration, access for users can be restricted during the upgrade by 
using the Default Entry Access Times.  Do not set the default entry times on the System 
Configuration screen, or this will lock out all users including administrators.  To restrict the 
users from logging on but retain access for administrators: 

1. Go to the User Groups screen, found under Synergy SIS > System > User. 

2. For each group of users, click on the Security Settings tab and enable the default 
entry access times, setting a beginning and ending time outside the time period for 
the upgrade. 

 
Figure 4.2 – User Groups Screen, Security Settings Tab 

3. Be sure to set the access times for the administrator group to No to disable any time 
restrictions for administrators. 

 

  

Caution:  Using either the LDAP integration or Default Entry Access 
Times methods to restrict users’ access to Synergy SIS will not block 
users that are currently logged into Synergy SIS.  It will only prevent 
users from logging on to the system.  To remove all access for even 
currently logged in users, stop the World Wide Web Publishing service 
on each web server.  Be sure to check the Job Queue screen as well to 
ensure all jobs have cleared the process server before the upgrade. 

 
 

  



Chapter Four System Installation Guide 
 

Copyright© 2013 Edupoint Educational Systems, LLC 87 
 

BACKUP 
 
As a precaution, please backup a copy of the existing web server directory, the current 
release zip file and any patches that have been applied, and the database before upgrading 
to a new release.  To backup each piece: 

• Web Server Directory – copy the root directory/folder of the Default Web Site on 
each web server to another folder.  If Synergy SIS was installed to a different folder, 
be sure to copy that folder as well.  The backup folder can always be copied back to 
the original location if access to the previous release is needed, or it can be 
accessed from its new location if retained in the website folder by appending the 
new folder name to the web address. 

• Release/Patches Files – keep a copy of the previous release and a copy of any 
patches applied in case it is necessary to re-install the previous release.  Note which 
patches were installed. 

• Database – while the database can be automatically backed up as part of the 
installation of the new release, it is always advisable to make a separate backup.  
To back up a SQL server database, right-click on the database from within SQL 
Server Management Studio and choose Backup Database from the Tasks menu. 

 

  

Caution:  Only data for the current year can be uploaded to the state 
from the latest release.  If it is necessary to upload data for previous 
years, the web server directory for that year, the database for that year, 
and the process server for that year must be installed and maintained 
separately from the current release. 

 
 

 

Note – By default, when installing a new release of the Synergy SIS 
software over an existing installation, the Microsoft SQL Server 
database is automatically backed up before any changes are made to 
the database.  To disable this automatic backup, check the box labeled 
Disable the Pre-Installation Backup of the MSSQL Server database. 
on the Options tab of the System Configuration screen, found under 
Synergy SIS > System > Setup.  To change the location where the 
backups are stored, enter the new path in the box provided.  By default, 
the backups are saved to C:\Program Files\Microsoft SQL 
Server\MSSQL\Backup. 

 
Figure 4.3 – Pre-Installation Backup Options 
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UNINSTALL THE WEB SERVERS  
 
To uninstall the web servers: 
 

 

Note – It may be necessary to remove some files manually, including 
custom installations.  When this situation arises, please contact the 
Edupoint technical support team at support@edupoint.com or by 
phone at 1-877-899-9111 option 1. 

 

1. On the server, open the Control Panel and select Add or Remove Programs 
(Programs and Features in Windows Server 2008).  

2. The Add or Remove Programs dialog box is displayed.  Click on the ST program in 
the list, and click the Remove (Uninstall in Windows Server 2008) button. 

 
Figure 4.4 – Add or Remove Programs Dialog Box 

3. A confirmation message pops-up to confirm the removal.  Click the Yes button to 
uninstall the software. 

 
Figure 4.5 - Confirmation Box 

mailto:support@edupoint.com


Chapter Four System Installation Guide 
 

Copyright© 2013 Edupoint Educational Systems, LLC 89 
 

4. The Progress Bar is displayed to indicate the progress of the removal. 

 
Figure 4.6 – The Progress Bar 

5. Repeat Steps 1 through 4 to uninstall each additional web server. 

UNINSTALL THE PROCESS SERVERS  
 
To uninstall the process servers: 

1. Open the ST Process Service Setup program by double-clicking the Process Server 
icon on the task bar, located in the lower-right corner of the screen.  If the icon does 
not appear in the task bar, click on the Start menu and go to the Edupoint folder 
under All Programs.  Click on the RTProcessSetup program. 

 
Figure 4.7 – Task Bar 

 
Figure 4.8 – All Programs Menu 

2. In the RT Process Service Setup program, click the Stop Service button. 

 
Figure 4.9 – RT Process Service Setup 



System Installation Guide Chapter Four 
 

90 Copyright© 2013 Edupoint Educational Systems, LLC 
 

3. The Process Service ribbon at the top of the page turns red and says Stopped when 
the process is stopped.  Click the OK button. 

 
Figure 4.10 – RT Process Service Setup, Stopped 

4. On the server, open the Control Panel and select Add or Remove Programs 
(Programs and Features in Windows Server 2008).  

5. The Add or Remove Programs dialog box is displayed.  Click on the RT Process 
Service program in the list, and click the Remove (Uninstall in Windows Server 
2008) button. 

 
Figure 4.11 – Add or Remove Programs 
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6. A confirmation message pops-up to confirm the removal.  Click the Yes button to 
uninstall the software. 

 
Figure 4.12 – Confirmation Message 

7. The Progress Bar is displayed to indicate the progress of the removal. 

 
Figure 4.13 – The Progress Bar 
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UNINSTALL ALL OTHER Synergy SIS SOFTWARE 
 
Any additional software installed, such as the DB Tools program or the Dashboard 
program, should be uninstalled prior to the upgrade as well.  To uninstall other Synergy SIS 
software: 

1. On the server where the software is installed, open the Control Panel and select 
Add or Remove Programs (Programs and Features in Windows Server 2008).  

2. The Add or Remove Programs dialog box is displayed.  Find the name of the other 
software in the list and click on it.  Then click the Remove (Uninstall in Windows 
Server 2008) button. 

 
Figure 4.14 – Add or Remove Programs Dialog Box 

3. A confirmation message pops-up to confirm the removal.  Click the Yes button to 
uninstall the software. 

 
Figure 4.15 - Confirmation Box 

4. The Progress Bar is displayed to indicate the progress of the removal. 

 
Figure 4.16 – The Progress Bar 

5. Repeat Steps 1 through 4 to uninstall each additional program. 
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INSTALL THE NEW RELEASE 
 
After everything has been uninstalled and backed up, install the new release following the 
instructions in Chapter Three of the guide.  The new release should be installed in the 
following order: 
 

 Install the web servers 

 Install the process servers 

 Reset IIS (optional) 

 Logon to the web servers 

 Start the process servers 

 Install all other Synergy SIS software (scanning, DBTools, etc.) 

 
 

  

Tip:  After an upgrade or re-installation, it may take a long time to load 
the initial page of Synergy SIS.  After that, normal speed should resume.  
To speed up this process, restart the Default Web Site (or the web site 
where Synergy SIS is installed) after installation or restart IIS. 
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Chapter Five: 
PATCH INSTALLATION 

 
 
 
 
 
 
 
 
 
 
 
 

In this chapter, the following topics are covered: 
► How to install the ST Dashboard software 
► How to setup the ST Dashboard software 
► How to apply a patch to the Synergy servers 
► Available dashboard options 
► How to use the dashboard to manage servers 
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SETTING UP ST DASHBOARD 
 
The ST Dashboard software provides an easy way to deploy patches to multiple Synergy 
web, process and database servers.  The ST Dashboard software can be installed on a 
central server and deploy patches from the central server to all Synergy servers in the 
district.  It can even be installed on a workstation for deployment.  By default, the software 
is installed with the Process Server software.  To install it on a different server, install the 
Process Server but do not start it. 
 
After installing the ST Dashboard, the next step is to add all of the Synergy servers to the 
dashboard so they can be managed.  Servers can be added to the dashboard 
automatically, or they can be added manually.  Servers can also be grouped together to 
make managing them easier.  To add the servers to the dashboard automatically: 

1. Start the ST Dashboard program by opening an Explore window and locating the 
Process Service Folder (usually found here: C:\Program Files\Edupoint\RT Process 
Service). Double click the RTDashboard.exe to launch the Dashboard. 

 
2. The Dashboard window will open. 

 
Figure 5.1 – RT Dashboard 
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3. From the Tools menu, click on Auto Discover Servers… 

 
Figure 5.2 – Tools Menu 

4. Select the type of server to search for (either Database, Process, Web, or All) from 
the Server Type drop-down list and click the Start Search button. 

 
Figure 5.3 – AutoDetect Servers 

5. The servers found will be listed above.  Click on the checkbox next to the servers to 
add, and click the OK button. 

 
Figure 5.4 – AutoDetectServers, Servers Found 
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6. The servers will then be listed in the main RT Dashboard window. 

 
Figure 5.5 – RT Dashboard, Servers Listed 

To add a server manually: 

1. From the Tools menu, click on Add Server Registration… 

 
Figure 5.6 – Tools Menu 

2. The AddServer window pops-up.  To add a process server, enter the Server IP 
Address and select Process as the Type of Server.  Click the OK button to add it. 

 
Figure 5.7 – Adding a Process Server 
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3. To add a database server, select Database from the Type of Server drop-down list.  
Enter the Server IP Address, and enter the name to display in the Dashboard tree 
in the Server Name box.  The server name can be anything.  Enter rev, rev for the 
User and Password, and select the Database Type from the drop-down list (either 
MSSQL or Oracle).  Enter the name of the database in the Database Name box, 
and then click the Test Connection button. 

 
Figure 5.8 – Adding a Database Server 

4. If the connection works, click OK to add the database server. 

5. To add a web server, select Web from the Type of Server drop-down list.  Enter the 
Server IP Address, and enter the name to display in the Dashboard tree in the 
Server Name box.  The server name can be anything.    Enter the folder where the 
web server is located on the server in the Server Local Access Path box, such as 
c:\inetpub\wwwroot.  Click OK to add the web server. 

 
Figure 5.9 – Adding a Web Server 
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Once the servers have been added, they can be separated into groups so that groups of 
servers can be managed together.  For example, the web servers could be grouped 
together, or all of the servers used for testing could be grouped.  To add a group: 

1. From the Tools menu, click on Add Group… 

 
Figure 5.10 – Tools Menu 

2. The Add Group window pops-up.  Enter a name for the new group and click OK. 

 
Figure 5.11 – Adding a Group 

3. Once the new group has been added, servers can be added to the group by 
dragging and dropping servers into the group.  Alternatively, they can be added 
manually if they are not listed already by clicking on the group, and then clicking on 
the Tools menu and selecting Add Server Registration. 

4. To rename a group, click on the group and then click on the Tools menu and select 
Rename Group. 

 
Figure 5.12 – Tools Menu 

5. Enter the new name of the group, and then click OK. 

 
Figure 5.13 – Rename Group 
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6. To delete a group, click on the group and then click on the Tools menu and select 
Delete <GROUPNAME>.   

 
Figure 5.14 – Tools Menu 

7. A confirmation message pops-up to verify the group should be deleted.  Click the 
OK button to delete the group. 

 
Figure 5.15 – Confirmation Message 

8. The group and any servers listed under the group are removed from the dashboard. 

  

Caution:  Once all the servers have been added, be sure to click on 
File…Save Settings to save all of the servers and groups that have 
been listed. 
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APPLYING A PATCH 
 
Once the servers have been added to the dashboard, patches can be applied to all of the 
servers listed in the dashboard at one time, or each server can be patched individually.  To 
apply a patch to the server: 

1. Download the patch file from the FTP site, as outlined in Chapter Two of this guide. 

2. Extract the patch file to a location on the server/workstation where the RT 
Dashboard software is installed. 

 

Note – The patches can be installed on either 32-bit or 64-bit 
installations.  The patches are all in one PKG file, and there is not a 
separate patch file for 64-bit installations. 

3. If the web server will be patched, turn off access to the web servers as outlined in 
Chapter Four. 
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4. From RT Dashboard, click on the Tools menu and select Deployment Assistant. 

 
Figure 5.16 – Tools Menu 

5. The Deployment Assistant window pops-up.  To select which files from the patch to 
deploy, click on the Choose Files button. 

 
Figure 5.17 – Deployment Assistant 
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6. Navigate to the folder in which the extracted patch is located. 

 
Figure 5.18 – Selecting Deployment Files 

7. Select which types of files to select from the drop-down list in the bottom right-hand 
corner.  Application Files and RT_PAD files generally need to be deployed to both 
the web servers and process servers.  SQL Files need to be deployed to the SQL 
server.  To keep everything working together, all files eventually need to be 
deployed to all the servers but they can be deployed one type at a time.  Select All 
Files to deploy the patch in one step. 

 
Figure 5.19 – Types of Deployment Files 
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8. Choose the package to deploy by clicking on it.  Once the file to be deployed is 
highlighted, click the Open button. 

 
Figure 5.20 – Files Selected For Deployment 

9. Select which servers to patch by clicking on the checkbox in front of each server.  
To check or uncheck all servers, click the Check All or Uncheck All button. 

 
Figure 5.21 – Selecting the Servers 
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10. To deploy the file to the selected servers, click the Deploy button.  To clear the list 
of files and select a file to deploy, click the Clear All button. 

11. Once the Deploy button is clicked, the Deployment Status window pops-up to show 
the status of the deployment. 

 
Figure 5.22 – Deployment Status 

12. When the deployment is complete, a box pops-up asking to open the log file.  Click 
OK to open the log file and review the files deployed. 

 
Figure 5.23 – Open Log File Confirmation 

13. The log file opens in a text file format, listing the status of the deployment of every 
file on every selected server.  The overall status of the deployment is stated at the 
bottom of the file.  Close the file after reviewing it. 

 
Figure 5.24 – Log File 

14. To view the actual files deployed and the files that were replaced, click on the Open 
Log File Folder button. 

 
Figure 5.25 – Deployment Status 
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15. A new window opens, displaying the contents of the deployment folder.  The 
deployment folder contains a subfolder labeled Backups, where copies of the files 
replaced are stored in separate subfolders labeled WS for web server files and PS 
for process server files.  Another subfolder labeled Files stores copies of the files to 
be deployed.  The Log.txt file is the log file displayed earlier. 

 
Figure 5.26 – Deployment Folder 

 

 

Note – This is the same folder that is displayed when clicking the 
Open Deployment Folder button from the main Deployment Assistant 
window.  By default, the deployment folder is C:\Program 
Files\Edupoint\RT Dashboard\Deployments.  The deployment folder 
location can be changed in the Dashboard Options as explained in 
the Other Dashboard Options section in this chapter. 

 

16. Close the folder, and then close the Deployment Status window by clicking the 
Close button.  Then click the Close button again to close the Deployment Assistant. 

  

Tip:  The log files and the files deployed can also be accessed through 
the Update screen in Synergy.  (Synergy SIS > System > Setup > 
Update) The Files tab displays a file by file breakdown of the installation.   
 
The Show Detail feature displays additional information on the individual 
installation file, including when and where it was installed and any errors 
that occurred.   

 
The deployment assistant can patch web, database or process servers.  However, there 
may be a patch available for one of the other Synergy SIS software programs such as the 
Photo Attach software or the Scanning software.  These patches will be located in the same 
location as the pkg file. 
 

 
Figure 5.27 – Updates Patch Folder 

 
The other applications are generally installed in the C:\Program Files\Edupoint folder.  Go 
to the folder for the application and remove the files that will be replaced to a backup folder.  
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Then extract the files from the ZIP file located in the patch folder, and place them in the 
application folder. 
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 SETTING DASHBOARD OPTIONS 
 
To set the dashboard options: 

1. Click on the File menu and select Dashboard Options. 

 
Figure 5.28 – File Menu 

2. The RT Dashboard Options dialog box pops-up.  To show larger icons in the 
dashboard tree, check the box titled Show Large Icons in Tree. 

 
Figure 5.29 – RT Dashboard Options 

3. By default, the dashboard checks the servers for status every 5 seconds.  To modify 
the time in between these checked, change the Poll Time. 

4.  By default, 5 server boxes are displayed on each row of the dashboard display.  To 
change the number of server boxes displayed, modify the Servers Per Line setting.  
Setting it to 1 server per line can be helpful, as then the other details of the server 
can be seen. 

 
Figure 5.30 – 5 Servers Per Line 

 

 
Figure 5.31 – One Server Per Line 
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5. To add more detail to the error messages, check the Verbose Messages box. 

6. To lock the dashboard and require a username and password to start it, enter the 
Username and New/Retype Password to be used in the Security section.  The first 
time this information is entered, leave the Current Password blank.  To change the 
password in the future, the Current Password will be required. 

7. To change the location of the deployment folder used for applying patches, enter the 
new location in the Staging Path box or click the  button to browse for the folder. 

 

  

Caution:  Every time a new server is added or deleted, or a new group 
is added or deleted, or the dashboard options are changed, be sure to 
save the new dashboard settings.  To save the settings, click on the File 
menu and select Save Settings. 

 
 
To view the version of the dashboard: 

1. Click on the Help menu and choose About… 

 
Figure 5.32 – Help Menu 

2. The About RT Dashboard windows pops-up.  It displays the Version number of the 
dashboard software, and the Date on which it was compiled.  It also shows the IP 
address of the computer on which the dashboard software is installed. 

 
Figure 5.33 – About RT Dashboard 

3. Click the Close button to close the window. 
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MANAGING SERVERS THROUGH THE DASHBOARD 
 
Once the servers have been added to the dashboard, several management options are 
available. 
 
To see the properties of a server: 

1. Right-click on the server to inspect it.  From the drop-down menu, select 
Properties.  Note that database servers do not have the Properties option. 

 
Figure 5.34 – Server Right-Click Menu 

2. The Properties dialog box shows the server Name (as entered for the dashboard), 
the IP Address, and the name of the computer on which it is installed (the Machine 
Name).  

 
3. The Path shows the location of the server software from the server itself, and the 

Remote Path shows the path used by other computers.  For web servers, this is the 
folder where the web software is installed, and for process servers it shows the 
location of the software in the Program Files folder.  To edit the location of the 
software, change the Path and click the OK button.  If the path is removed, the 
Properties and Open Server will no longer be available until the server is deleted 
and re-added.  To close the box without changes, click the Cancel button. 
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To view the program files for either a web server or process server: 

1. Right-click the server to inspect.  From the drop-down menu, select Open Folder.  
Note that database servers do not have the Open Folder option. 

 
Figure 5.35 – Server Right-Click Menu 

2. Windows Explorer opens the folder where the server files are located. 

 
Figure 5.36 – Server Folder 

3. To close the folder, click the X in the upper right-hand corner of the window. 

 
 
To view and identify each server and its current status: 

1. Each type of server is assigned a different icon. 

 
Figure 5.37 – Web Server 

 
Figure 5.38 - Process Server 

 
Figure 5.39 – Database Server 

2. The color of each server box indicates the current status of the server.  Green 
indicates the server is up and running. 

 
Figure 5.40 – Server Up and Running 
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3. Yellow indicates the server is paused. 

 
Figure 5.41 – Server Paused 

4. Red indicates the server is stopped or otherwise unreachable. 

 
Figure 5.42 – Server Stopped or Down 

 
 
To manage the process servers: 

1. To manage groups of process servers, click on either the root of the dashboard tree 
to control all process servers or click on a group to control only a certain group of 
process servers. 

2. Right-click on the selected group, and choose one of the following options: 

 
Figure 5.43 – Group Menu 

• Start All Services – start all stopped process servers 

• Pause All Process Servers – pause all process servers 

• Resume All Process Servers – restart all paused process servers 

• Stop All Services – stop all process servers 

3. To manage an individual process server, right-click on the process server. 

 
Figure 5.44 – Process Server Menu 
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4. Choose to Stop Process Server or Pause Process Server when the server is 
running.  If the server is paused, the option will be to Resume Process Server or 
Stop Process Server.  If the server is stopped, the option will be to Start Process 
Server or Pause Process Server. 

5. To confirm any selected action, click the OK button. 

 
Figure 5.45 – Confirmation Box 
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